Solid State Logic

SL 9000 J Series

Computer Operator's Manual

SECTION 2

Projects
Section 2 Index

B
Backup in Project menu 2-26

C
Current/Default/None in Project menu 2-18

G
G Series Data, Importing 2-31

I
Info in Project menu 2-24

L
LOAD PROJECT button 2-19
LOAD SELECTIVE button 2-19

P
Proj Setup in MISC menu 2-29
Projects contents 2-16
Project menu 2-4
Project menu options 2-18
Projects – Backing up 2-26
Projects – Clearing Data 2-14
Projects – Copying 2-26
Projects – Creating New 2-5
Projects – Current Project 2-4
Projects – Default Project 2-3
Projects – Deleting 2-21
Projects – Elements, a list of 2-16
Projects – Front Panel Controls 2-19
Projects – Importing G Series Data 2-31
Projects – Information pop-up 2-25
Projects – Loading 2-7
Projects – Personal Default Projects 2-6
Projects – Project Saving in Practice 2-13
Projects – Renaming 2-24
Projects – Restoring 2-26
Projects – Save Protection 2-30
Projects – Saving Project Versions 2-11
Projects – Selective Loading 2-9
Projects – Selective Saving 2-12

R
Reminder in Project menu 2-18
Restore in Project menu 2-26

S
SAVE PROJECT button 2-20
SAVE SELECTIVE (TR) button 2-20
Save Sel in Project menu 2-12

W
Write Protect in Project menu 2-18

NOTES
<table>
<thead>
<tr>
<th>System Disk</th>
<th>Projects</th>
<th>Versions</th>
<th>Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects Directory</td>
<td>The Act</td>
<td>Basic Track</td>
<td>Automation Data #1</td>
</tr>
<tr>
<td></td>
<td>Song 1</td>
<td>22.5.99 12:48pm</td>
<td>Automation Modes #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Channel Names #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Desk Setup #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fader Protection #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Film Scorer #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Hard &amp; Soft Groups #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MIDI Events List #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Match &amp; Play Switch Groups #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Serial Machines Config #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Snapshot Positions #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Switch Protection #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Timecode Memories #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total Recall Setup #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Events List #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Macro Routing Keys #1</td>
</tr>
<tr>
<td></td>
<td>O/Dubs Day 1</td>
<td>22.5.99 22:55pm</td>
<td>Automation Data #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Automation Modes #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Channel Names #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Desk Setup #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fader Protection #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Film Scorer #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Hard &amp; Soft Groups #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MIDI Events List #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Match &amp; Play Switch Groups #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Serial Machines Config #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Snapshot Positions #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Switch Protection #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Timecode Memories #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total Recall Setup #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Events List #2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Macro Routing Keys #2</td>
</tr>
<tr>
<td></td>
<td>Spasm</td>
<td>Rough</td>
<td>Automation Data #1</td>
</tr>
<tr>
<td></td>
<td>Extended Mix</td>
<td>24.5.99 02:23am</td>
<td>Automation Modes #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Channel Names #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Desk Setup #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fader Protection #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Film Scorer #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Hard &amp; Soft Groups #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MIDI Events List #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Match &amp; Play Switch Groups #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Serial Machines Config #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Snapshot Positions #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Switch Protection #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Timecode Memories #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Total Recall Setup #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Events List #1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Macro Routing Keys #1</td>
</tr>
</tbody>
</table>
Projects

Any data generated by the J Series Computer during a session is held in volatile RAM (Random Access Memory). If, for any reason, power to the computer is interrupted, all data held in RAM will be lost. The computer also contains a hard disk, known as the ‘system disk’, on to which data in RAM may be saved, and from which data may be loaded into RAM.

The storage of session data on the system disk is organised using folders or directories called Projects; a single Project should be used for each piece of audio material (or song). As much data as required may be stored within each Project.

If you have previously used SSL's G Series software, the concept of Titles in which you store different versions of Mixes, Total Recall Setups, Cues, Track Lists etc., will all be familiar to you. Projects have a similar, but greatly expanded, function in the J Series Computer, and also cover system setup information relating to fader grouping, machine control, timecode standards, user-programmable keys, etc.

Projects are kept on the system disk until they need to be archived (for long-term storage or transfer to a different studio), at which point they can be copied onto Magneto-Optical (MO) disks (note that we do not recommend SuperDisk floppies for long term storage).

When information needs to be saved, you have the choice of saving the entire contents of RAM to the system disk, or you may choose instead to save individual elements of the Project (for example, just a Total Recall file). Regardless of the choice you make, each ‘save’ will generate a new user-named ‘Version’ to hold that information within the Project. If only specific items have been saved, the system will identify those elements which were not selected, and will refer instead to the most recently saved of these. This allows updated files to be saved without having to save everything all over again. For example, you have just saved Version ‘Perfect’, then realise that the fader grouping needs changing. You can change the grouping and save a new version of the ‘Hard & Soft Groups’ file that holds the grouping settings, naming the new Version ‘Even More Perfect’. Loading this Version (all element files) would load not only the correct set of fader groups, but also every other element file previously saved in Version ‘Perfect’.
When the J Series Computer is booted up, the system's 'Default Project' can be automatically loaded, presenting the console in a fully configured state right from the start.

Beyond this point, two basic situations can occur:

- You are starting a brand new session and need to create a new Project.
- You intend to continue working with the same Project as on a previous session.

In the first case, you will need to create a new Project, based either on the Default Project (see opposite) or a previously created Project, into which you can save data relating to that particular session. In the second case, you simply need to load the relevant Project. Full details of all the procedures required can be found on the following pages.

In the following descriptions, menu selections and other boxes on the screen are shown in Bold. Although the most commonly used of these are available as hardware buttons switches on the Master Control panel, we advise you to initially use the pen and tablet interface, so that you become familiar with it.

A system-level Proj Setup pop-up, available via the MISC/System menu, enables system-wide masking of Project element file types that are not relevant to particular installations. Once selected for masking, these items will not be shown in any further Project displays, and the system will not attempt to load, save or clear data relating to them.

Before using the system, please check that the correct elements have been selected/masked. See Page 2-29 for more details.
When a new J Series console system is installed, or a new software version is released, the software is provided with a 'standard' Default Project devised by SSL. This will contain basic setup information such as user-defined key functions, default automation settings, etc. (see below).

In order that the Default Project can be loaded on bootup, it must be saved with the name **Default Project**. Note that Projects thus named will automatically (the next time the computer is booted up) take on a 4-digit suffix that represents your J Series Computer's unique network ID. This is to avoid confusion in facilities that feature multiple networked processors. To rename an existing Project as the Default Project, use the Copy function described on Page 2-26 and name the copy **Default Project:nnnn**, where **nnnn** is the network ID.

The Default Project should never be used to store session-specific information. If this happens, subsequent creation of new Projects may result in unwanted default features being transferred to the new Project. The Default Project should therefore always be set to **Write Protected** mode (see Page 2-18 for details).

Although the contents of the Default Project are normally loaded on bootup, the system can remember which Project you were last using and make that the 'Current' Project when the computer restarts (see Page 2-17). New information can only be saved to the Current Project.

### SSL-defined Default Project

The SSL-defined Default Project contains a number of predefined mode settings (which may, of course, be modified according to taste):

<table>
<thead>
<tr>
<th>Grouping</th>
<th>All large faders to Group 0. Group masters not grouped. Remove Motor Effect not set to activate when motors are turned off.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Settings</td>
<td>Motors On, Insert Mixing On, Absolute Fader Status, Trim Renull on, Snap on, all others off.</td>
</tr>
<tr>
<td>Automation Modes</td>
<td>Large, small, group and master faders: Rollback/Join. Large, small and group cuts, group solos: Rollback. Auxes (FX1-6, cue stereo, EQ, insert): Mix Fill.</td>
</tr>
<tr>
<td>Switch Protection</td>
<td>Large fader cut, group fader cut: Automated. Small fader cut, all FX, cut, EQ, insert, group solos: Protected Manual.</td>
</tr>
</tbody>
</table>
The Current Project

It is important to be aware, at any time, which Project is the Current Project. When you save and load elements of any Project, these are always saved to, and loaded from, the Current Project. The name of the Current Project is shown in the long blue Current Project : box above the other Project menu entries (see below). However, just because the correct name appears in this box, it does not necessarily mean that the elements of this Project have been loaded for use (particularly when the computer has just been rebooted!).

The Current Project can be changed by stabbing on the Current Project : box, at which point a Project selector pop-up, automatically highlighting the existing Current Project will appear:

Stabbing on the name of any other Project followed by OK will select a new Current Project.

The Project Menu

Projects are manipulated using selections in the MIX-DES/Project menu (see below). The most useful of these are replicated by buttons on the Master Control panel.

A number of options allow:

- New Projects to be created, based on any other Project in the system.
- Existing Projects to be loaded into RAM.
- New Versions and Elements to be saved in the Current Project.
- Projects to be copied to and from the system, MO and floppy disks.
- Project Elements to be cleared from RAM.
- Existing Projects and Versions within these Projects to be renamed.
- Existing Projects to be deleted from the system disk.
Before starting a new session, a new Project should always be created, in order that information can be safely stored on the system disk.

Select MIX-DESK/Project/New, and a ‘Select Template Project’ pop-up will appear (see below) allowing the selection of any existing Projects on which to base the new Project.

![Select Template Project Pop-Up](image)

The system will automatically select the Default Project for this operation (in which case no further selection is required), and we recommend that you work with this unless you clearly understand the implications of doing otherwise.

To select any Project other than the Default, scroll the list and stab on a Project name to select it (it will highlight in yellow); stab on another to change your choice. Note that the most recent Version within the selected Project will be used as the basis of the new Project.

Stab on Quit to cancel the creation of a new Project, or stab on OK to proceed, and a QWERTY pop-up will appear to allow the newly created Project to be named (at this point, don’t worry if you make a mistake, as the name can be changed at a later point by using the Rename function – see Page 2-23).

Once the relevant files have been copied, a final pop-up appears asking if you wish to load the newly created Project into RAM, with Yes (OK) or No (Quit) options (note that you can use the Master Control panel OK or QUIT buttons here.)
Regardless of whether you choose to load or not, the system will automatically make the new Project the Current Project, so that subsequently saved data will be saved into it. Note that, if the new Project is loaded, any existing RAM data will be overwritten (and lost if not already saved), and that any existing RAM data can only be saved by means of the various Save functions (see Page 2-11).

When a new Project is created, the most recent element files from the Default (or selected Project) are copied. This includes all file types, irrespective of Project element masking, but note that masked file types are not subsequently loaded. The first Version in the new Project will be automatically named Default Version.

---

**Personal Default Projects**

Rather than basing new Projects on a particular studio’s Default Project, freelance engineers can create a personalised Default Project that travels with them. This will ensure that any 9000 Series console used by that engineer can be operated in a familiar manner.

A favourite Version can be created in the usual way, saved to floppy disk and then installed on each and every J/K Series Computer encountered. When presented with the ‘Select Template Project’ pop-up, select the personalised Project instead of the studio’s Default, and proceed in the usual way.

Please note that not using the studio’s Default settings may involve changes to functions of the macro keys on the Master Control panel, which will not be reflected in the button cap engraving.
Rather than create a new Project to work with, you may wish to work on an existing Project, created at an earlier date. If so, it will need to be loaded and made current.

Select Load from the MIX-DESK/Project menu and you will be presented with a pop-up similar to that shown below. This allows a chosen source Project and Version to be loaded into RAM.

The first column in the pop-up displays a list of all Projects currently stored on the system disk. This column can be viewed either alphabetically (Name), or by date (Date), by stabbing in the box below Sort By on the far left of the pop-up. Project names will be truncated in Date mode to allow for the display of the Project creation dates.

A shortcut to finding the Project you want is provided by the grey bar at the bottom of the pop-up, beneath the words Search for a Project. Stabbing on this bar will present the familiar QWERTY pop-up into which a search string—a series of characters—may be entered; any Project name that contains the entered characters will remain displayed in the Project list.

To choose a Project to load into RAM, simply scroll the list (if necessary) and stab on the required Project name (which will now be highlighted in yellow). Once a Project has been highlighted, the second column of the pop-up will display a list of all Versions belonging to that Project (see over the page).

Once again, this column can also be sorted either by alphabetical Name or by creation Date, by stabbing on the box directly above the Version column.
Loading a Project (cont)

To choose the Version of data to be loaded into RAM, simply scroll the list (if necessary) until the name of the required Version is shown, and stab on it to highlight the Version name in yellow:

![Version List](image)

Often, you may wish to Load the most recently saved Version, and the Load pop-up provides a shortcut in the form of a **Latest Version** box beneath the **Version List**; stabbing on this will automatically highlight the most recently saved Version.

Note that you can navigate through the Project and Version lists using the Master Control panel’s cursor keys. Once you have mastered this simple technique, it will provide a rapid, pen free method of file selection on several similar pop-ups.

Once you have selected the correct Version, you may simply stab on **OK** (or press the Master Control panel **OK** button). The system will then automatically load all element files for the selected Version, except those that have been masked on the **MISC/System/Proj Setup** pop-up (see Page 2-30).

As before, on loading a Project, any existing data in RAM will be lost (unless it has been previously saved to the system disk), with the exception of Automation Data. In this case you will be asked if you want to load the latest mix from the new Project, which will be added to the Mix Pass list if you do so – see Section 5 for more on this).

Once the loading process has been completed, all Load pop-ups will be cleared from the screen. If you do not wish to load all of a Version’s data, but wish instead to load only certain elements from that Version, simply stab the **Selective...** box on the Project Load pop-up.
Having entered the Project/Load pop-up and selected a Project to load, stabbing on Selective... at the foot of the Load pop-up will present another pop-up listing all the available element files that can be individually selected for loading into RAM:

At the top of the pop-up, the selected Project name and its creation time and date are displayed. You can stab on this name and select a different Project using the resulting QWERTY pop-up, but you might find it easier just to Quit the pop-up and select an alternative Project from the scrolling list in the main Load pop-up.

On the far left of the pop-up, a scrolling list of all the available Versions belonging to the selected Project is shown. Stabbing on a particular Version will highlight its name in yellow, and automatically make the elements related to that Version available for selection.

To the right of the Version list is a scrolling list of all the available element file types. Note that this only shows elements that have not been masked using MISC/System/Proj Setup – see Page 2-30.

Next to each element name is a box with either a cross or a red-highlighted tick, which is used to determine which files are selected for loading. Stab on the box to toggle between ticks (selected) and crosses (not selected). All selections can be cleared (returning all ticks to crosses) by stabbing on the Clear box, and the entire selection of ticks and crosses can be toggled by stabbing on Flip.
Selective Project Loading (cont)

When a Version has been selected, the File No column will indicate the 'level' of each element file in that Version. The very first Version ever created will contain files all numbered '1', and any file subsequently saved will be numbered incrementally.

To the right of the File No column is another, labelled Latest, which will indicate how many files have been created for each type.

Regardless of which Project Version has been selected, the Next and Prev boxes beneath the File No column can be used to step incrementally forwards and backwards through all the individual element files. This ability is especially useful if you ever have to work with a Project created with very early J Series software, in which case there will be no Versions.

Once you have selected the correct Project, Version (or numbered file types) and ticked only those files that you want to load, stabbing on OK (or pressing the Master Control panel OK button) will immediately load your selection into RAM.

As before, when loading a Project or Version, any existing data will be lost (unless it had been previously saved to the system disk), with the exception of Automation Data (in which case any newly loaded mix data will be added to the Mix Pass list – see Section 5 for more on this).

Alternatively, you may stab on Quit (or press the Master Control panel QUIT button) to cancel the loading process.
In the bottom left-hand corner of the Selective Load pop-up is a box designated Fire Macro 21 which, when selected, is highlighted in red. This function can be disregarded (and left unselected) in the majority of J Series installations. However, for your information, whenever a full Project Version is loaded, Macro 21 (referred to as Project Macro on the Macro Setup display) is automatically fired at the end of the loading process. The Default Project contains no programmed data for this macro so it has no effect on the system. On the Selective Load pop-up, you are given the choice of having the macro fire whenever any element file, in any Project, is loaded. Although not widely used, the ability to ‘Do Snapshot # 1’ when loading a Project may be a useful way of restoring a monitor balance (in which case Macro 21 would need programming with this function). See Section 5 for more on Snapshots. Section 8 covers the creation and use of macros.

When viewing the Selective Load file listing, the Automation Data and Total Recall Setup elements have a name bar beneath them (see opposite), and it is possible to directly load these items by stabbing in the bar. A resulting file pop-up will show individual files listed by their Version names and dates. Stabbing on a listed item will automatically load it into RAM.

See Page 2-18 on loading Project information from the Master Control panel.

Once the session gets underway, you will need to save data to the system disk on a regular basis. Stab on Save in the MIX-DESK/Project menu to save the current contents of RAM to disk, in the Current Project. When you do this, a QWERTY pop-up will appear for you to enter the name of the Version.

When saving, the following conditions are observed:

- Items which have been modified in RAM will be saved, unless:
  
  An item has been masked in MISC/System/Proj Setup.
  An item has been Save Protected (ticked) in MISC/System/Proj Setup (see Page 2-30).

- Items which have not been modified in RAM since they were last saved will not be saved; instead, the Version system will remember the file number of those items already stored on the system disk and will correctly load them if the entire Version just saved is loaded back into RAM.
Selective Saving (Save Sel)

Stabbing on the Save Sel option in the Project menu will produce a file list pop-up similar to that used for selective loading:

![Save Sel pop-up]

At the top of the pop-up, the selected Project (into which you will save information) and its creation time and date are displayed. You can stab on the name box and enter the name of a different Project using the resulting QWERTY pop-up, but you might find it easier to Quit the pop-up and select an alternative Project by stabbing on the Current Project box.

On the left of the pop-up, a scrolling list of all the Versions belonging to the selected Project is shown, which may be useful when trying to determine what to call the Version you will create when you have saved.

To the right of the Versions list is a scrolling list of all the available element file types. Note that this will not list elements which have been masked using MISC/System Proj Setup, as described on Page 2-30. The elements shown in normal type may be saved; any ‘greyed-out’ elements may not be saved, since they have been Write Protected on the Proj Setup pop-up. You can, however, override the protection by stabbing on the cross (x) box next to that element name to change it to a red-highlighted tick (✓). Note that this action is only temporary; the next time you use this pop-up, that element will be once again Write Protected. Furthermore, as soon as you stab on OK you will be asked if you really mean to overwrite a protected element.
To determine which elements will be saved, stab on the box to the right of the element name to toggle between ticks (selected) and crosses (not selected). A selection can be cleared (returning all ticks to crosses) by stabbing on the Clear box, and the entire selection of ticks and crosses can be toggled by stabbing on Flip.

Once you have ticked only those files that you want to save, stabbing on OK (or pressing the Master Control panel OK button) will save your selection to the system disk. At this point, a QWERTY pop-up will appear allowing you to enter the name of this Version; this name will also be used to name Automation Data and Total Recall files, if these items have been selected to be saved.

Alternatively, you may stab on Quit (or press the Master Control panel QUIT button) to cancel the saving process.

To successfully save data, the Current Project (into which you are trying to save) must not be write-protected. If it is, a 'Unable to Save - Project is Write Protected' alert will appear on the screen (stab on the box to remove it from the display).

See Page 2-19 on saving Project information from the Master Control panel.

Create a new Project – this will copy the last-saved files (of every type) from the template Project you have chosen (probably the Default Project). Load the new Project when prompted to do so, to reset the console with your chosen default settings.

During the session you might change a lot of information in RAM but, in this example, we’ll assume that you haven’t altered any fader protection settings.

When you do a Save, all the changes you have made will be saved to disk, and ‘bound together’ in a new Project Version. Because the grouping information has not been changed, a new Fader Protection file will not be saved. However, the system remembers the number of the Fader Protection file already on disk (the default settings in this case) and automatically makes that file number part of the Version you have just created.
If you use Save Sel instead of Save, only the file types you have selected will be saved to disk. The most recently saved files of the types not selected will be remembered, and both previous and newly-saved files become part of the Version you have just created.

When available space on the system disk falls below 20% of its total capacity, a warning message, indicating the remaining percentage will appear in the status bar after each successful save. When disk space is reduced to 10% of its total capacity, the saving process is interrupted by a warning dialogue box, requiring a Yes/No action to continue. See Section 1 for more details.

Clearing Project Data

The facility is provided to erase information from RAM without affecting data already stored on the system disk. For example, you might wish to remove all the marks stored in the Events List because the song structure or timecode values have radically changed. You could use the Events List Delete function to delete each individual item in the list, but it is much simpler to use Project/Clear, which will erase all the entries in one go.

Stabbing Clear in the Project menu produces the following on-screen dialogue box:

Three choices are available:

- **Quit** – Cancels without making changes to the contents of RAM.
- **Selective** – offers a choice of data to clear from RAM.
- **All** – clears the complete contents of the RAM. Use with caution!
If you select Selective, a file listing pop-up will appear on screen, with a scrolling list of all the available file types:

![Select Items to Clear](image)

Note that only files which have not been masked (using MISC/System/Proj Setup – see Page 2-30) will be shown in the list.

Next to each file type is a box with either a cross or a red-highlighted tick, which is used to determine the type of data to be cleared. Stab on the box to toggle between ticks (selected) and crosses (not selected).

A selection can be cleared (returning all ticks to crosses) by stabbing on the Clear box, and the entire selection of ticks and crosses can be reversed, or toggled, by stabbing on Flip.

Once you have ticked only those files that you want to clear, stabbing on OK (or pressing the Master Control panel OK button) will immediately clear your selection from RAM. Alternatively, you may stab on Quit (or press the Master Control panel QUIT button) to cancel the clearing process.
<table>
<thead>
<tr>
<th><strong>Project Contents</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automation data</strong></td>
</tr>
<tr>
<td><strong>Automation mode</strong></td>
</tr>
<tr>
<td><strong>Channel Names</strong></td>
</tr>
<tr>
<td><strong>Desk Setup</strong></td>
</tr>
<tr>
<td><strong>Fader Macros</strong></td>
</tr>
<tr>
<td><strong>Fader Protection</strong></td>
</tr>
<tr>
<td><strong>Film Scorer</strong></td>
</tr>
<tr>
<td><strong>Hard &amp; Soft Groups</strong></td>
</tr>
<tr>
<td><strong>MIDI Events List</strong></td>
</tr>
<tr>
<td><strong>Match &amp; Play</strong></td>
</tr>
<tr>
<td><strong>Serial Machines Config</strong></td>
</tr>
<tr>
<td><strong>Snapshot Positions</strong></td>
</tr>
<tr>
<td><strong>Switch Protection</strong></td>
</tr>
</tbody>
</table>
Timecode Memories: The timecode values stored with the instant locate buttons – TC1-5 on the Master Control panel. (See Section 3)

Total Recall Setup: Total Recall Setups (see Section 7)

Events List: Events List data, including Cues (see Section 4) but excluding 'filter' settings (see Desk Setup above)

Macro Routing Keys: Contents of the computer's user-programmable keys. These may be programmed with macros to perform a wide range of functions (see Section 8)

The DiskTrack System element is not applicable to SL 9000 J Series systems, and should be deselected in the MISC/System/Proj Setup pop-up (see Page 2-29).
Project Menu Options

Reminder

The Reminder box in the Project menu, can be used to warn you to perform a Project save after a specified timeout has expired. This is probably most useful when used in conjunction with Save Sel (see Page 2-12), to save mix data on a regular basis.

Stab on the Reminder box to set the timeout period between 0-1440 minutes – the default value is 10 minutes. Progress of the countdown will be shown in the Reminder box. To indicate that the period has expired, and a save is necessary, the Reminder box will change to Save Now and flash pink/green; if the Project menu has been deselected, then the Project box in the MIX-DESK menu will flash in pink.

Each time you execute a save, the timeout period is reset and the countdown begins again. If you do not wish to save data when the timeout period has expired, stab on the Save Now box and enter 0 on the pop-up; this will cancel the countdown. To reset the timeout once the countdown has started, simply stab on the reminder box, enter the new period and hit OK.

Write Protect

The Current Project can be write protected by stabbing on the Write Protect box in the Project menu (the box turns red).

Please note that, in the case of the Default Project only, this setting will override the setting in the Proj Setup pop-up (see Page 2-30). The last setting selected in either way will determine the write protected status of the Default Project. Always keep the Default Project write protected unless you specifically wish to modify its settings.

Current/Default/None

Stabbing on this ‘last’ box in the Project menu provides a small pop-up to choose which Project will be loaded when the computer is turned on or rebooted. Stab on the required option: Current (the last Current Project prior to the reboot will be reloaded), Default (the Default Project settings will be automatically loaded into RAM) or None. In the first two cases, the most recently created Version will be loaded from the selected Project.
Front panel buttons are provided to facilitate the most common of Project management functions – Load and Save.

When pressed, the LOAD PROJECT button will call up the same pop-up as Project/Load (see Page 2-7). Select a version (see below) and, when you stab on the OK box or press the OK button, all file elements for that Version will be loaded, subject to any masking in the MISC/System/Proj Setup pop-up (see Page 2-30). Selecting the LOAD PROJECT button also allows Selective... to be chosen from the pop-up, although that function is directly supported by the adjacent Master Control panel button (see above).

The Master Control panel cursor keys can be used to select different Projects and their Versions:

When only a Project is highlighted (and none of its Versions), the up/down keys scroll through the list of available Projects, highlighting a different Project with each press. Once selected, the right key moves into the Version list, and then the up/down keys scroll through the list of available Versions, highlighting a different one with each press. The left key will return the up/down keys to act upon the Project list.

Using the cursor keys enables a Project and Version to be selected for loading without having to use the pen and tablet at all.

When LOAD SELECTIVE is pressed, it calls up the Project/Load pop-up’s Selective... display, enabling Versions to be selected from the Current Project, and the selection of any Version’s element file types.

Initially, the up/down keys scroll through the list of available Versions, highlighting a different one with each keypress. Once a Version is selected, the right key moves into the ticks and crosses column, and then the up/down keys scroll through the list of available file types.
LOAD SELECTIVE (cont)

When a tick or cross is highlighted, pressing the Master Control panel OK button will toggle crosses to ticks, and ticks to crosses. Once the correct arrangement has been selected, the left key will return the up/down keys to act upon the Version list, at which point the OK button can be used to initiate loading (or the up/down keys can be used to select a different Version).

Using the cursor keys enables a Version and file types to be selected for loading without having to use the pen and tablet at all.

SAVE PROJECT

SAVE PROJECT, when pressed, creates a new Project Version. This will incorporate all unsaved data in RAM along with references to the existing files on disk that correspond to unchanged RAM settings which do not require saving again (got it?). Total Recall Setups and Automation Data files will both be given the name of the Version, and only one QWERTY pop-up is encountered. Enter the Version name on the computer's hardware keyboard.

When available space on the system disk falls below 20% of its total capacity, a warning message, indicating the remaining percentage will appear in the status bar after each successful save. When disk space is reduced to 10% of its total capacity, the saving process is interrupted by a warning dialogue box, requiring a Yes/No action to continue. See Section 1 for more details.

SAVE SELECTIVE (TR)

Pressing the SAVE SELECTIVE (TR) button calls up the Project/Save Sel pop-up (see Page 2-12), enabling individual Project file types to be saved.

As the (TR) engraving suggests, the 'Total Recall Setup' Project file element is automatically selected for saving whenever this button is pressed. This automatic selection can, of course, be overridden and alternative file types can be selected on-screen. Subsequent use of the button will present the same previously selected elements, enabling repeated save operations without unnecessary fuss. Note, however, that the 'Total Recall Setup' element will be automatically reselected every time the SAVE SELECTIVE (TR) button is pressed.

Once required elements have been selected, stabbing OK on the pop-up, or pressing the Master Control panel OK button, will, as with SAVE PROJECT, create a new Project Version, with reference to file elements that already exist on the system disk.
The Project menu's Delete function enables the deletion of:

- Whole Projects (all Versions and element files).
- Single Versions from a selected Project (including its files which do not relate to any other Version that will remain).
- Multiple Versions from a selected Project (including their files which do not relate to any other Version that will remain).
- Any combination of the above.

Note that, for obvious reasons, the Current Project may not be deleted.

Selecting Delete produces the following pop-up:

Boxes on the left of the pop-up allow you to choose the source of the Projects you wish to delete – MO (Magneto-Optical disk), FLOPPY, or SYSTEM (the computer's hard disk).

Selecting one of these options will present a second pop-up, displaying a list of available Projects and their associated Versions on that device:
Deleting Projects (cont)

An entire Project may be selected for deletion by stabbing on its name without selecting any of its Versions. Alternatively, once the Project has been selected, individual Versions may then also be selected by stabbing on their names in the right hand list.

In the example above, one Project and two of its Versions have been selected. Only these two versions will be deleted, leaving the other four versions in that Project intact.

If you are having a ‘tidy up’ on the system disk, it’s possible you may wish to select multiple Projects and Versions to delete. To check if you have selected whole Projects and/or Versions as well, stab on the highlighted Project names again. If any Versions belonging to the Project you stab on have been selected, they will appear highlighted in the Version column, and you will not be able to deselect the Project until you have also deselected these Versions. If the whole Project has been selected, stabbing on it will cancel its selection (and it will need to be reselected).

The list of Projects may be sorted by Name or creation Date, by stabbing in the Sort By box. The Project list may also be sifted so that only those with names containing a series of specified characters are displayed. Stab in the box below Search For a Project, and enter the required character string on the resulting QWERTY pop-up. To view the entire list once again, select the same box and clear the string by using ‘Del’ on the physical keyboard, CLEAR on the Master Control panel’s numeric keypad, or by stabbing the Clear box on the QWERTY pop-up, followed by Enter or OK.

Versions may be sorted either by their creation Date or by their creation Time by stabbing in the box on the top right of the pop-up. The most recently created Version may be immediately selected by simply stabbing on Latest Version.

Once you have selected the required Projects and/or Versions for deletion, stab on OK on the pop-up or press the OK button on the Master Control panel. If you wish to cancel the process, select Quit (QUIT).
Once you have OK'd, the original **Delete** pop-up returns (see below), listing all the items that have been selected; red text indicates a Project that will be deleted in its entirety (including all its Versions); black text indicates individual Project Versions.

Even if every Version in a Project is selected, each item will be shown in black. All data within such a Project will be deleted (Versions and all files), but the Project directory will remain and may be used for saving fresh information, if required.

At this point, items can be deselected from the list by stabbing on **REMOVE** (the box turns yellow) and then on the particular item you wish to remove. When you have finished the deselection, stab on **REMOVE** again to turn the function off (the box will turn grey again).

Note that, not surprisingly, Projects and/or their Versions cannot be deleted if the Project is Write Protected.

Note also that there is no “Do you really want to do this?” dialogue – as soon as you stab **OK**, the files will be deleted. Stabbing on **Quit** (**QUIT**) will cancel the deletion process before it starts, and upon re-entering the pop-up, all items will need to be reselected.

If you delete individual Versions from a Project, the next time that Project is loaded, the **Selective Project Load** pop-up FileNo numbers may not reflect the deletions you have made. For example, if there were originally 6 Versions and you deleted Versions 1, 3, and 5, you will still be able to toggle through all 6 Versions using the Next and Prev functions, although you will be unable to load any data from Versions 1, 3, and 5 (this preserves a true representation of the Version history). The Version list on the left of this pop-up will, of course, list only Versions 2 and 6.
Renaming Projects

An entire Project, or just one of its Versions, may be renamed at any time using the **Project/Rename** function. When stabbed, this provides a similar selection pop-up as **Project/Delete**:

![Renaming Project Pop-Up](image)

Select either the Project or Version to rename; your selection will be shown with a yellow background. Now stab on **OK** (or press the **OK** button on the Master Control panel). To cancel the process at this stage, stab on **Quit** (**QUIT**).

Note that the Current Project cannot be renamed unless another Project is first made current. Versions within the Current Project may be renamed.

When the pop-up is **OK**d, a QWERTY pop-up will appear showing the current Project or Version name – type a new name and stab on **OK** or hit the **OK** button.

Note that Projects and/or their Versions cannot be renamed if the Project is Write Protected.
Useful session information may be appended to individual Projects via the **Info** entry in the **Project** menu. Stab on the box and a text file pop-up will appear:

![PROJECT INFO FOR Dave's Chums](image)

The default file includes a list of relevant categories which can be appended by placing the cursor to the right of the item and typing on the console's dedicated keyboard. The Project name and created date is automatically set up when you create a new Project (see Page 2-5); the rest of the information will come from whatever has been set up in the Default Project. Additional information may be recorded (delay times, mix notes, lyrics etc.) by scrolling to the bottom of the pop-up and adding new text.

Text may be selected by stabbing on the first character of the section to be selected, and then dragging across the rest of the text. Alternatively, hold down the keyboard Shift key and press the cursor keys. Once selected, text may be cut or copied, and subsequently pasted back in at the cursor position through use of the **Cut**, **Copy**, and **Paste** boxes at the top of the pop-up or the console’s keyboard (Control-X, Control-C, and Control-V respectively). The box marked **F** will toggle to a **P** if you stab on it – this governs the width of the displayed text, either Fixed or **Proportional**. To save any changes made, stab **Save**, or to cancel and exit, stab on **Quit**.

To save a file under a different name, stab on the file name at the top of the pop-up. This will launch the QWERTY pop-up, and entering a different name will save the edited file in the same directory under that name. File names may have a maximum of 28 characters.

Note that an **Info** file is created in every new Project regardless of the template used, and that each Project contains only one **Info** file.
Copying Projects and/or Versions

You may need to copy Projects for a variety of reasons, one of the most important being the regular backup and archiving of valuable session data. The copy routines described below are also used to restore archived Projects to the system disk.

Projects are copied using the Backup and Restore entries in the Project menu. Backup is used to make copies from the system disk to MO, floppy or back onto the system disk itself (not recommended), and Restore is used to make copies onto the system disk from MO, floppy or the system disk itself (not recommended).

The following options are available:

• A single Project may be copied in its entirety, with the option to change the name of the copy created.

• Multiple Projects may be copied in their entirety, retaining their original names.

The following descriptions (unless stated otherwise) are based on the Backup function; Restore uses a virtually identical process.

Selecting Backup presents a pop-up allowing the selection of a destination device (stab on MO or FLOPPY).

Now stab on the empty box in the middle of the pop-up.
This will present a second pop-up from which items to be copied may be selected:

Stab on the Project(s) you wish to backup (they highlight in yellow). As each Project is selected, the Versions in that Project will be listed to the right (see above).

Once the selection has been completed, stab on OK and the original pop-up will return, listing the selected Project(s):

If not previously selected, now select the correct destination volume – FLOPPY or MO (note this is not necessary for Restore).
Copying Projects (cont)

Hit OK, and if a single Project is being copied, a QWERTY pop-up will appear asking for the name of the destination Project; the existing name will be automatically entered, so that if you do not wish to create a different name, simply hit OK on the pop-up or press OK on the Master Control panel. The copy process will now commence; progress reports are shown in the Status bar.

If multiple Projects have been selected, the computer will begin copying them immediately, without asking for new names.

When the copying is over, a status bar message will appear confirming that the process has been successfully completed.

Note that it is not possible to copy individual Versions directly from one Project to another. To do this, first load the Project and Version that you want to copy. Now change the Current Project: to the destination Project and use the SAVE PROJECT function to save the loaded settings into the that Project.

Individual Project Element Versions can also be copied from one Project to another using the same method. In this case, use the SAVE SELECTIVE function to save the chosen Element(s) into a new Version of the destination Project.

If you wish to backup a Project to MO, but only want to include the latest Version, first create a new ‘backup’ Project and, using the method described above, save the required Version into that Project before copying it to the MO.

If you want to backup a Project and include a number of (but not all) key Versions, simply delete the unwanted Versions before you make the backup copy. See the note on Page 2-23 about deleting non-contiguous Versions.

Note that the Copy facility in the FILE/SETUP menu may not be used to copy Projects.
Proj Setup, a system-wide function in the MISC/System menu, allows Project element file types, that are not relevant to particular installations, to be masked. These items will then not be shown in any Project pop-ups or displays, and the system will not attempt to load, save or clear data relating to them.

This pop-up also includes a Save Protection facility, which allows items that have been set up as defaults to be protected from further unwanted saves (see next page).

Note that this menu selection can be password protected and, if so, a reminder to this effect will be given in the status bar when you stab on the Proj Setup box. Contact the facility’s Technical Manager or see Section 9 if you need to gain access.

When selected, the Proj Setup pop-up (see above) shows a scrolling list of all Project element file types. The name of each element may be stabbed to change its background colour.

An item displayed with a light grey background will be available for use (unmasked), and an item displayed with a dark grey background will be removed from all other Project pop-ups – it will not be loaded from, or saved to, a Project; this is known as a ‘masked’ item. The screenshot above shows that Film Scorer and MIDI Events List have been masked and won’t ever be loaded or saved.
Depending on your particular installation, file types for masking might include:

Fader Macros
Film Scorer
MIDI Events List (if you don’t use Bar/Beats)
DiskTrack System

The choices made here will depend on your system and its usage, and should only be made by suitably qualified technical staff. See Page 2-15 for a description of all element file functions.

Masked items cannot be loaded or saved to disk; make selections carefully.

Save Protection for Project Elements

Alongside the file type names, tick/cross boxes allow the selection of unmasked items (green background) to be Save Protected.

Items bearing a tick with a green background next to them can be loaded from disk, but cannot be saved, unless specifically selected on the Save Selective pop-up (see Page 2-12).

Elements that you might consider protecting include:

Serial Machines Config
Total Recall Setup
Macro Routing Keys

If you Save Protect Total Recall Setup, so that the Master Control panel SAVE PROJECT button (and on-screen Save function) never save a Total Recall Setup, please note that the Master Control panel SAVE SELECTIVE (TR) button will always preselect Total Recall Setup for saving, regardless of a Save Protection tick.

Items selected for Save Protection may be toggled using Flip; all selections may be Cleared.

The system’s Default Project may also be Write Protected on the Proj Setup pop-up by selecting the Protect Default box (which will then turn red). Please note that the Default Project write protection may be cancelled from the MIX-DESK/Project menu when the Default Project is the Current Project.
Once the **Proj Setup** 'Project Template' has been modified, settings should be saved to disk by stabbing on the **Store** box. **Quit** will retain all changes until the computer is next rebooted, but will not save them to disk (note that this is subtly different to the computer's other **Quit** functions).

G Series project data – Mixes (including software groups), Cues, and Track Lists may all be copied into the Current Project. In addition, hardware group data can also be imported from G Series Total Recall Setups. Data can be transferred from 3.5" Floppy Disks or 20MB Data Cartridges.

Data on 3.5" Floppy Disks is loaded via the floppy drive unit on the front of the J Series Computer. To import data from Data Cartridges, a set of drives must be connected to the SCSI port on the J Series Computer's rear connector panel. Note that a SCSI terminator must be fitted to this connector when Data Cartridge drives are not connected.

Select the **FILE/SETUP/Import** menu. To access the disk you wish to import data from, stab on either **Bernoulli** or **Floppy**. After a few seconds, while the computer accesses the G Series disk, a pop-up appears that has, on the right, a column of boxes representing the different types of G Series data ('Lists'). The area on the left is used to show the items/versions stored within those lists.

For example, if you are importing data from a 20MB Data Cartridge, **Reel** will be highlighted at the top of the column on the right, and the area on the left will list the Reels you can access. Stab on a Reel name to select that Reel (it will be highlighted). Now select **Title** in the right hand column, and stab on a Title from the list that appears.

Having accessed the required Title, items within that Title can be selected for transfer by stabbing on the appropriate box in the right hand column.
Items that can be transferred will be listed, on the left of the pop-up, in black; items that appear in a sort of gold colour cannot be transferred. These include Events, S. Pres (Sync Presets), Info (the List Page), Notes, Drop-Ins and Presets (Real Time system).

To transfer a single item from the Mix or (Total Recall) Setup lists, simply stab on it. To transfer entire lists, such as Cues or Track Lists, stab on the message ‘CLICK/STAB THIS LINE TO LOAD ALL ENTRIES’ that appears at the top of the left hand panel. Do not stab on an item more than once, as this will copy the data across twice (or even more times if you get frantic). The status bar will confirm that the transfer is taking place.

Note that items from the G Series Cue List will be added to any existing entries in the current J Series Events List. If you only want to use the G Series Cues, remember to clear the ‘Events List’ element of the Project first. Use the Project/Clear/Selective function for this (see Page 2-14). For more on Events Lists, see Section 4.

All transferred data is simply copied into the computer’s RAM and will need to be saved to the system disk using the Project/Save function (see Page 2-11).

If you import G Series data which has a Soft Group whose master was a hardware Group Fader, the Soft Group will be replicated exactly as it was on the G Series console, with the hardware Group Fader as master (as seen in the Soft Group Setup pop-up). However, since this is not a valid selection on a J Series console (apart from assignments to hardware Group 0 – see Section 5), the hardware Group Fader will not control the Soft Group, only any faders assigned to it in a hardware group.
Solid State Logic

SL 9000 J Series

Computer Operator's Manual

SECTION 4

Events and Track Lists
Section 4 Index

< and > buttons on Master Control panel 4-7

C
Capture Clips 4-7
CHANNEL NAMES button 4-9
Channel and Track Lists 4-9
Channel Names in Desk Setup menu 4-9
Clips on Events pop-up 4-8
Copy Tracks on Channel Names pop-up 4-11

E
Events – see also Marks 4-1
Events, Deleting 4-5
Events, Editing 4-4
Events List, Creating a 4-2
Events List and Projects 4-7
Events List and locates 4-6

F
Follow on Events pop-up 4-2, 4-6

I
Insert on Events pop-up 4-5

L
Large/Small on Events pop-up 4-6
Locating with the Events List 4-6

M
MARK button 4-2
Marks, Locating to 4-6
Marks, Moving 4-5
Marks, Naming 4-3
Marks, Renaming 4-4
Marks, Renumbering 4-4
MIX-DESK/Events pop-up 4-1

N
NAME MARK button 4-3

Notes
Track and Channel Lists 4-9
Track List, Creating a 4-9
After, or even during the recording of a track, you will probably want to create a cue/mark list. The list will consist of a series of timecode-marked points, which enable you to easily identify, and locate to, different parts of the recording.

With the J Series Computer, this list is known as the ‘Events List’. The Events List can contain several different items but the only type of event you are likely to use on a regular basis is a Mark. The list may also display audio Clip Start and End times generated by the Capture Clip function – see Page 4-7, On/Off Macro events (see Section 8) and Remote On/Off RelayBox events (see Section 9).

The Events List may appear with all the above by default. However, the Default Project can be set up so that certain events are ‘filtered out’ of the list for clarity. The ‘Desk Setup’ element of a Project (see Section 2) stores the settings of the Events List filters (see Page 4-2).

Select MIX-DESK/Events. This calls up a full-sized version of the Events List:

A mini version of the list is provided when the Overview display (see Section 5) is selected and also when the Timecode Calculator (TC) is called up (see Section 3).
Events List Filters

Regardless of settings in the Default Project, you can customise the Events List at any time, and have it display only the information you want to see. To do this, stab on the Event All box at the top of the list, and a pop-up will appear (see left) showing the various event types as previously described (the box is marked Event All by default, signifying that all types of events will be displayed, but may show any of the available event types).

To limit the list to show only one or more event types, stab on their entries in the pop-up to select (blue) or deselect them. When you OK out of the pop-up, the Event All box will now reflect your choice – Selection if you have chosen more than one event type, or the event type itself, i.e. Mark, Clips etc., if you have chosen a single type.

You can also limit the display of events to selected channels. This is more appropriate if you use the Capture Clips function (see Page 4-7), and has no particular application when creating a cue list. Stab on the (default) All Chans box to produce a channel selector pop-up, and deselect/select individual channels as required. Deselecting Global will remove global marks (made with the front panel MARK button) from the list. As you will discover, deselecting Global is not a good idea as it is these marks that form the basis of an Events List!

Creating an Events List

To create a useful Events List proceed as follows:

Use the MARK button (located on the Master Control panel, to the left of the transport controls) to define the position of the marks. You can do this ‘on-the-fly’ as the source machine is running, or alternatively locate to the correct timecode position and hit the MARK button. This will also place marks, represented by horizontal black lines, on the Overview display. See Section 5 for more on the Overview display.

You will notice (if the Events List is still on the screen) that when marks are generated with the MARK button, they are automatically numbered in the order they are created. These numbers are followed by an asterisk (1 *, 2 *, 3 * etc.). The count is re-initialised each time a new Project is created. The current event is highlighted in yellow. If Follow is selected (blue) then the list will scroll as the timecode advances.
Automatically numbered marks/cues are fine if you can remember what particular point in the recording is represented by that mark! It makes much more sense to name the marks as you create them so that you can instantly recognise the points they represent.

To do this, having hit the **MARK** button, press the **NAME MARK** button just to the right. This calls up the **QWERTY** pop-up to prompt you to name the current mark, ie. the one highlighted in yellow in the Events List.

If it is not already somewhere on the console surface, pull out the keyboard drawer under the tablet, type an appropriate name and hit Enter. Note that, when the **QWERTY** pop-up appears, the relevant mark number and asterisk (1 * etc.) is provided in the 'name ' box. You may be tempted to delete the number and asterisk but, as you will see later, they can provide a quick method of locating to any mark.

The **QWERTY** pop-up is described in Section 1. You may find its 'keyword' function useful for the fast naming of Verse and Chorus marks, for example.

If you have already made several marks and now wish to name them, first select the mark by stabbing on it (note that the system locates to that mark when you do this) and hit the **NAME MARK** button. Alternatively, you can stab on the **Name** function in the **Edit** menu on the Events List (see Page 4-4).

Note that the **MARK** and **NAME MARK** functions will still work whether the Events List is on the screen or not.
Editing Event Information

Renumbering Marks

Having created a reasonable number of marks, you may wish to edit some of the entries:

First of all, it's possible that the auto numbering system (1*, 2*, 3* etc.) has got out of step. This will be simply because you have created further marks at earlier timecodes than the initial marks. Events are always listed in ascending timecode; to reset the numbers in ascending order, select Edit on the Events List and stab on the Renumber box (see below). Note that this will only put the numbers into the correct sequence, it will not shuffle the actual marks or their names about in any way. If marks have been deleted (see next page), the remaining events will be renumbered to provide a continuous sequence. Note also that the renumbering is only applied to marks whose names start with n* where n is a number.

Renaming Marks

In addition to the NAME MARK button, marks can be named or renamed with the Name function in the Events List Edit menu.

Stab on the Name box (it goes red) and then stab on the mark you wish to name. The QWERTY pop-up will appear. As before, use the dedicated keyboard for convenience or, since the pen is in your hand, use the QWERTY pop-up; retain any n* in the name to aid easy locates. The Name function will stay selected for further naming/renaming. Deselect the box when finished.
All events can be deleted with the exception of audio clip starts and ends generated by the Capture Clips function (see Page 4-7). Select **Delete** in the **Edit** menu and then stab on the event/marker you wish to delete. No confirmation will be requested so make sure you know what you are doing! The **Delete** function automatically deselects after each deletion. To latch the function on for multiple deletes, press and hold the switch on the side of the pen when you select the **Delete** box. Remember to deselect the box when finished, otherwise the next time you stab on a mark it will be deleted!

When a mark is almost in the right place, you may wish to nudge its timecode value by a few frames. Select **Move** in the **Edit** menu and then stab on the event/marker you wish to move. The timecode pop-up (and mini Events List) will appear (see below); enter a new time or nudge the existing time with the `< or >` frame jog boxes. Stab **OK** to effect the change. The **Move** function will stay reselected in case you wish to adjust more marks. Deselect the box when finished.

Entry of timecode, or nudging in seconds/frames, can also be carried out from the Master Control panel by using the numeric keypad and/or the cursor keys (see Section 1 for more details).

Note that all of the above editing functions can be applied to other types of events, with the exception of audio clip starts and ends which cannot be named, moved or deleted, and macro and remote macro entries which cannot be named.

The **Insert** function in the **Edit** menu is used to enter macros into the Events List. See Section 8 for more details.

The **Clips** box at the top left of the Events List provides access to the Capture Clips function. See Page 4-7 for more details.
Follow and Large/Small Functions

If Follow on the main Events List is selected (blue) then the list will scroll as timecode advances. Toggling the Large/Small box provides a normal or small typeface version of the list.

The mini Events List beneath the Overview display (see Section 5), and the Events List that appears with the timecode calculator, always reflect any changes made to the main Events List, with the exception of the typeface size which remains normal on the mini lists.

Locating to Mark Points

Locating to mark points couldn't be easier. With either the main Events List or the Overview mini Events List on the screen, simply stab the pen on the mark you wish to locate to, and the system will locate to that position.

Alternatively, enter the mark's unique system-given number (1 *, 2 *, 3 * etc.) via the numeric keypad on the Master Control panel (no need to add the *), and hit OK to action the locate.

If you have the main Events List on-screen when you do this, you will see the number entered in the bar at the foot of the list. If the number you enter does not exist, the bar will turn yellow and No Match will be displayed.

If the mark is not numbered as above, the first letter (or as many letters as are necessary to distinguish one mark from another) can be entered from the keyboard followed by Enter, to locate to that mark. If there is any confusion with similarly named marks, you will be told the number of possible matches and you must try again with more identifying characters. As before, the bar at the foot of the main Events List will reflect the search entry and any error messages. Entered numbers are cleared from the bar automatically at this stage but names must be cleared with the Master Control panel CLEAR button or the dedicated keyboard's backspace delete key.

Note that the Events List does not have to be on-screen to locate to a mark point by either of the above methods.

Pressing OK on the Master Control panel (or Enter on the dedicated keyboard) a second time will repeat the last locate command.
The `< and >` buttons, to the left of the TC 1-5 buttons on the Master Control panel, can be used to step the system from one event to another if set up for this function in the **Desk Config /Transport Layout** entry of the **FILE/SETUP** menu (see Section 9 for more details).

All information in the Events List can be saved to a Project under ‘Events List’ (no surprise there!). The current selection of Events List ‘filters’ (i.e., which channel/what type of events) is saved under ‘Desk Setup’.

Capture Clips is an innovative feature which allows the system to capture audio ‘clip’ information from console channels, via the opening and closing of gates in the channels’ dynamics sections. Once captured, an on-screen representation of the audio can be used as an aid to the editing of automation data (see Section 5).

First you need to set up the gates on those channels which have the necessary audio coming through them. The system assumes that audio is present when no LEDs are lit on the gate meter. If this is your first experience with Capture Clips, we suggest you read through this section before proceeding, so that you are aware of the potential benefits of the function.

Note that clips will be captured from the first time you play the source machine after the Capture Clips function is armed. Make sure that the machine is located to the correct start point before you select channels as described below. To avoid capturing excessive material, you should start and end the run in silence. The simplest way to do this is to select a **SOLO** button on an unused channel. If you don’t start and end with the gates closed, the system may assume that there is a clip running from 00:00:00:00 up to the start of the track, and another clip running from the end of the track to 23:59:59:24(29)!
Now select MIX-DESK/Events and stab on the Clips box at the top left of the Events List. This produces two new boxes to the right – Capture and Clear.

To select the channels you want to capture clips on, stab on Capture. The channel selector pop-up will appear. Select the relevant channels and OK out of the pop-up. To select a sequential range of channels, simply hold down the fader status button of the first channel and press the button on the last channel.

Play the multitrack. When you hit Stop, you will be given the option to Save or Discard the captured clips. If you save the clips, select the MIX-DESK/Overview display to view the captured audio for each channel represented by a series of blue blocks. A function below the Overview display, Fit Audio, will restrict the window span to the start and end of the capture.

If you subsequently wish to discard the clips on one or more channels, select Clips followed by Clear on the Events List. This again calls up the channel selector pop-up. Choose the channels on which you want to clear the Captured Clips information, then press OK.

The J Series Computer’s mix system provides a set of automation modes which are specifically designed for use with captured clips – see Section 5.
Track and Channel Lists

The J Series Computer provides the ability to create and store both Track and Channel Lists on a per-Project basis. The Track List, not surprisingly, provides a record of which sources (instruments, vocals etc.) you have recorded onto which tracks of the multitrack machine. A Channel List provides a record of which console channels those tracks are feeding; if no 'machine output' to 'channel input' cross-patching has taken place, then the Channel List will be the same as the Track List. As soon as any feeds are cross-patched this should be reflected in the Channel List, as this information will be vital for a later mix or remix.

The principles used to enter information in either type of list are the same; as a typical example, we will describe how to create a Track List.

Press the CHANNEL NAMES button on the Master Control panel or select FILE/SETUP/Desk Setup/Channel Names. A display, similar to that shown below, will appear on the screen.

Stab on the box in the top left hand corner of the display. This produces a menu enabling you to choose one of the following types of list: Channel list 1-48, 49-96, 97-120, Track list 1, 2, 3, 4. The four Track Lists are designed to correspond to each of the four machines that can be controlled via the Machine Control display (see Section 3).
Creating a Track List (cont)

As with many other J Series facilities, entries can be made on these pages either from the dedicated keyboard, or by using the pen and tablet with the on-screen QWERTY keyboard.

Initially, the Enter key on the dedicated keyboard will toggle through all of the Track/Channel List pages. Use the cursor keys on the keyboard to navigate to the required track/channel name box (outlined in white). Press Enter on the keyboard, and then type the required name. Press Enter again to confirm the name and the next entry in the list will be highlighted; press Enter to enter a new name or change the existing name.

The pen can also be used to select track/channel boxes and, in this case, multiple boxes may be selected. This is useful where you might have, for example, several tracks dedicated to to the same musician. First stab and drag through the tracks to be named. Now enter only the name (eg. Bruce) on the QWERTY pop-up or dedicated keyboard, followed by OK or Enter, and the selected tracks will be automatically named Bruce 1, Bruce 2, Bruce 3, etc. To start the sequence from a higher number enter, for example, Bruce 4 to result in Bruce 4, Bruce 5, Bruce 6 etc.

If you want to delete any entries, select Delete (red) and stab on the name(s) to be erased. A number of contiguous names can be deleted by stabbing on one and dragging across the others; all the boxes covered will turn red, and upon releasing the pen, you will be prompted to confirm the multiple deletion. The Delete box will remain enabled until a second stab turns it grey again.

To move to another list, cursor back up to the list type box and use the Enter key again to toggle to the required page.

To clear a Track or Channel List from the screen, simply stab outside the pop-up or deselect the CHANNEL NAMES button.
The **Copy Tracks** function enables Track List information to be copied into a Channel List. Unless you have cross-patched 48 tracks or more, this will make a useful starting point for the Channel List. Select **Copy Tracks** and a **Copy Configuration** pop-up will appear (see right).

Stab on a box in the **Machine** column (one box for each machine port) that corresponds to the Track List you wish to copy. Select **Direct** for user-selectable mapping of the copy or **Sony 9-pin** for channel-to-record mapping from the **Machines/Serial** display. *(If this latter statement confuses you, just select **Direct** and read on!)*

If you select **Direct**, a numeric pop-up will appear allowing you to specify the number of tracks to copy. Enter the number (usually 48) and hit **OK**. Now stab on the relevant **Chan** box to enter the channel number into which the first copied track will be entered, or in other words, onto which of the three Channel Lists (Channels 1-48, 49-96 or 97-120). Hit **OK** to effect the copy.

Other items in the **Desk Setup** menu are described elsewhere in this manual.